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Introduction
In this tutorial, you will become familiar with the Toxik UI and workflow.
After completing this tutorial, you will be able to do the following:

■ Customize the UI (See: Customizing the Format of your Composition on
page 7)

■ Create compositions (See: Create a New Composition on page 8)

■ Control composition formats

■ Import footage (See: Importing Footage on page 13)

■ Add tools (See: Adding Tools to Your Composition on page 18)

■ Adjust parameters

■ Keyframe parameters

■ Work in the Schematic view

■ And finally, render your work (See: Rendering the Results on page 46)

Before You Begin
First, ensure you have the files needed to follow along and complete this
tutorial. Download the compressed file named “Renders.” Create a folder
named “Toxik 101” and a sub-folder named Renders. Then extract the
“Renders” compressed file in the Renders folder.
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Once you have copied these files and Toxik is installed, you can launch Toxik.
When Toxik opens, you see the Toxik UI.

The Toxik UI
The default Toxik UI has two viewers displayed: the Schematic view on the
left and the Player view on the right, both of which are located in the upper
viewer area of the UI. The Tool Details area runs along the bottom of the UI.
The Tool Details has several tabs on the left, including the Animation, Pick
List and Composition tabs. These tabs are always present. As we add tools, the
parameters for those tools will be accessible here.
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You can have up to four stationary views and eight floating windows. You
can adjust the size of these views by positioning your cursor over the dividing
line and then clicking the line and dragging it either left or right. You can
also change the position of the views -- in our example, we’ll reverse them --
but to do this you need to access the Tools, Views and Pick List tabs. These
three tabs are elements of the UI that you can access by using the Gate UI.
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To access the Tools, Views and Pick List tabs, do the following:

1 Hit the tilde (~) key or click the middle-mouse button.

2 The Gate UI appears. Swipe through the east gate to access the Tools,
Views and Pick List tabs.

3 Click the Views tab.

4 Select the Schematic view and drag it into the viewport where the Player
view currently sits. Now you’ll have two Schematic views.
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5 Repeat the steps above, but this time, select the Player view and drag it
into the viewport where the original Schematic view is sitting.

Each direction that you swipe through using the Gate UI is represented by
the four cardinal directions: North, South, East and West. Each direction gives
you access to a different element of the UI. In addition to the Tools, Views
and Pick list tabs, you can also access the Composition Browser, the overview
Schematic view and a viewer’s options by swiping through the Gate UI.

To access the Composition Browser, do the following:

1 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.

2 Swipe through the west gate. The Composition Browser appears.

3 To retract the Composition Browser, drag the cursor to the right.

To access the Schematic overview, do the following:

1 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.

2 Swipe through the north gate. The Schematic overview appears.

3 To retract the Schematic overview, drag the cursor down.
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To access a viewer’s options at the bottom of the UI, do the following:

1 Position your cursor over the viewer.

2 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.

3 Swipe through the south gate. The viewer’s options appear.

4 To retract the viewer’s options, drag the cursor up.

Customizing the Format of your
Composition
You will need to change some of the preferences, such as the formatting of
your composition, for the purposes of this tutorial. The default Toxik format
is 35 mm Full Aperture 2K, however the files that you’ll need for this tutorial
are HD 720p.

To change the composition preferences, do the following:

1 Open the Project Preferences dialog box. Either click on the film reel icon
located in the bottom-right corner of the UI, go to the Edit menu and
select Project Preferences, or click Ctrl + Alt + P.

2 Select the Compositions tab.

3 Click the Format field to reveal the list of formats. Choose the HD 720p
option.

The composition project preferences will change to match the HD 720p
format. You will now need to change some additional options to match
the file format you will be working with.

4 Click the Channels label to display the channel options.

5 Click the RGBA option to set the channel options to Red, Green, Blue
and Alpha.

6 Click the Depth label to display the depth options.

7 Click the 16 bit option to set the channel options to 16 Bit depth.

8 Finally, click the OK button to close the Project Preferences dialog box.
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Create a New Composition
Now it’s time to create a new composition.

To create a new composition, do the following:

1 Go to the File menu and choose “New.”

2 The Create Composition dialog appears. Navigate to the folder you named
Toxik101.

3 In the name field, enter a name for the new composition, for example
“Red Car.”

4 Click the Create button, which is located in the lower-right corner.
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You now have a new composition created and open. You can see the name
of the newly created composition along the bottom of the UI in the lower-right
corner. You can also see that there is an Output node in the Schematic view.
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Adding a Ramp Tool to the Schematic
The first image you will add will be a radial ramp image. You will create this
ramp using one of Toxik’s image generators.

To add a Radial Ramp tool, do the following:

1 Hit the tilde (~) key or click your middle-mouse button, then swipe
through the east gate to access the Tools, Views and Pick List tabs.

2 Select the Tools tab, then click the Image Generation folder.

3 Choose the Radial Ramp tool and drag it into the Schematic view, making
sure not to release the mouse button.

4 Bring the cursor and the tool icon over the output node’s input on the
left side of the node.

5 The input for the output node will highlight, indicating you are about
to connect the ramp to the output node.

6 Release the mouse button and the radial ramp is added to the composition
and connected to the output node.

The ramp tool is selected by default. In the Player we see the output of the
ramp and in the Tool Details area we see a new tab named Radial Ramp. All
the parameters for the tool are now available to us.
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Changing the Ramp Colors

To Change the ramp colors, do the following:

1 Click the color swatch under the start parameters. The color picker
appears.

2 Click the advanced button to expand the color picker.

3 Click the white swatch in the color palette to set start color of the ramp.

4 Click the OK button to apply the color and discard the color picker dialog
box.

5 Click on the end swatch under its parameters and the color picker will
appear again.

6 Click the light blue swatch in the color palette to set the end color of the
ramp.

7 Click the OK button to apply the color and discard the color picker dialog
box.
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Customizing Other Ramp Attributes
On the detailed area for the ramp you can adjust the X and Y center, the X
and Y radius, the middle position and the X and Y falloff with the fields. Or
you can adjust these parameters using the controls in the Player. You will
adjust these parameters and add keyframes to the adjustments.

■ Make sure you are at the first frame by holding the Shift key and pressing
the left arrow key.

■ Click on the “Autokey” button to turn on auto keyframing.

■ Click in the X Center field and adjust the value to 120.

■ Click in the Y Center field and adjust the value to -60.

■ Click in the X Radius field and adjust the value to 490.

■ Click in the Y Radius field and adjust the value to 350.

■ With the value for the Middle At field set to 50, right-click in the field and
choose “Set Keyframe” to add a key.

■ Click in the X Falloff field and adjust the value to 560.

■ Click in the Y Falloff field and set the value to 315.

You’ll notice that a green solid line appears in the fields you have adjusted.
The green line indicates that a parameter has keyframes and you are at a frame
with a key. If you scrub the current time marker to a different frame you will
see that there is now a red line in the fields indicating that this parameter has
keyframes, but the current frame you are at does not have a key.
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You will now need to add new values at the 19th frame. To do so, do the
following:

1 Drag the current frame indicator in the timeline area to the 19th frame.

2 Click in the X Center field and adjust the value to 275.

3 Click in the Y Center field and adjust the value to -90.

4 Click in the X Radius field and adjust the value to 840.

5 With the value for the Y Radius field set to 350, right-click in the field
and choose “Set Keyframe” to add a key.

6 Click in the Middle At field and adjust the value to 95.

If you scrub the playback now you can see the animation of the radial ramp’s
parameters. Also notice the keyframe marks in the timeline area. When a
selected tool has keyframes, you see the keys displayed at the frames they are
on. Click on the play forward button or hit the L key to play back the frames.

Go to the File menu and choose “Save” or use the Control S hotkey to save
your composition.

Importing Footage
You will now start to import footage into your composition.
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To import footage into your composition, do the following:

1 Hit the tilde (~) key or click your middle-mouse button and swipe through
the east gate to access the Tools tab.

In the tool’s panel, you’ll notice there are tools with a sphere icon next
to them. These are called super tools. The Image Import super tool is used
to import footage into the composition.

2 Select the Image Import super tool and drag and drop it into the Schematic
view without connecting it to any other nodes.

The tool is added and it is currently selected. The Tool Details area now
displays the parameters for this tool. You’ll see a path and a browse folder
icon along the top of the Tool Details area.

3 Click on the browse button to access your drives attached to your
computer.

4 The Image Import browser dialog box will open.

5 Use the navigation pane on the left to navigate and open the folder
named “Toxik 101.”

6 Click on the “Renders” folder to open the folder and you will see all of
the files we will be using for this tutorial.

Creating Bookmarks
Since you will need to access this folder often during this tutorial, it will be
helpful to create a bookmark for this path.

To create a Bookmark, do the following:

1 Click on the Bookmark button. The bookmark options will appear.

2 Click on the “Add Bookmark” option and the name option appears.

3 Name this bookmark “Red Car Renders” and click OK.

If we click on the bookmark label again you’ll see the bookmark has been
added to the list area for the bookmarks
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Now that you’ve created a bookmark, do the following:

1 In the “Renders” folder select the BG Land file.

2 Click on the OK button located at the lower right corner of the Image
Import dialog box.

3 Now the Image Import tool’s path is set to the BG Land PNG sequence
on your hard drive.

4 In the Image Import Tool Details area we see all of the format information
about this image sequence footage.

5 Click the play forward button to playback the frames of this sequence.

6 Finally, turn the Autokey option off.
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Zooming and Panning in the Player
There are several hotkeys you can use to zoom in, zoom out and pan the Player
and the Schematic view. To zoom and pan, do the following:

■ Hold the control key and space bar and click and drag down or to the left
to zoom out of the Player.

■ Hold the control key and space bar and click and drag up or to the right
to zoom into the Player.

■ Hold the space bar and click and drag the cursor to pan the Player.

The same zooming and panning hotkeys works in the Schematic view. There
are two hotkeys that you’ll use often to zoom the Player so that it displays the
pixels at a 1 to 1 pixel ratio, and so that it fits the frame within the Player’s
current display size.

To fit the frame within the Player’s current size, use the following hotkeys:

1 Bring your cursor over the Player.

2 Hold the Ctrl key and press the Home key.

To display the pixels of the frame to a 1 to 1 ratio with the resolution of your
monitor, use the following hotkey:

1 Bring your cursor over the Player.

2 Press the Home key.

Customizing the Player Options
The Player is currently set to display the tool output and that is why you didn’t
see anything in the Player until you added the tool and it was selected. You
control the Player’s options. You can access the Player’s options from the Gate
UI.

To access the Player options:

1 Bring your cursor over the Player.

2 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.
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3 Swipe through the south gate.

The Player options will appear at the bottom of the UI. These options
allow you to control what is displayed in the Player, for example, tools,
channels, information, and proxy levels.

4 Ensure that the display option is set to tool output.

5 Ensure that the View option is set to Chns:RGBA.

6 Ensure that the proxy option is set to full.

7 To retract the Player options, swipe north or up.

Using Hotkeys to Control the Player
Options
When using hotkeys, the position of the cursor controls what is affect by the
hotkeys.

To set the Player to display the main output of a composition, use the
following hotkeys:

1 Position the cursor over the Player.

2 Press the 7 key above the letter keys.
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The Player will display the main output of the composition which has the
ramp attached to it.

To set the Player to display the currently selected tool’s output, use the
following hotkey:

1 Position the cursor over the Player.

2 Press the 6 key above the letter keys.

The Player will display the Image Import node with the BG land sequence
since it is selected.

To control the channel view options using hotkeys, use the following hotkeys:

1 Position the cursor over the Player.

2 To display the Chns:RGBA option, press the C key.

3 To display the RGB option, hold the Ctrl and Shift keys, and press the C
key.

4 To display the A option press the A key.

5 To display the red channel press the R key.

6 To display the green channel press the G key.

7 To display the blue channel press the B key.

8 Press the C key to return the display option to Chns:RGBA.

Adding Tools to Your Composition
You will now start adding tools to your composition.

To add tools to your composition, do the following:

1 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.

2 Swipe through the east gate.

3 Select the composition folder from the Tools tab.

4 Select the Blend & Comp tool located at the bottom of the tools tab.

18 | Chapter 1   Toxik Tutorial



5 Drag and drop the tool onto the connection line between the Radial
Ramp tool and the main output node.

The connection line will highlight when the tool is over the line; when you
release the tool, it will be added between the two nodes and automatically
connected.

This is the default workflow with composition tools; if you add a composition
tool to a connection line or a node in the Schematic view the tools output
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will be connected to the compositions back or B input. Looking at the Blend
& Comp tool, you will see that there are several inputs.

■ Bring your cursor over the inputs; the input beneath the cursor will be
highlighted and the name will appear.

■ Move your cursor over each input and you will see that there is the front,
the back, the matte and the masking input.

■ Bring your cursor over the BG land output on the right side of the node
and it will be highlighted.

■ Click and drag on the highlighted output.

■ Drag the cursor over the front input of the Blend & Comp and the front
input will be highlighted.

■ Release the cursor and the output of the BG lane node will be connected
to the front input of the Blend & Comp.

■ Select the Blend & Comp node in the Schematic view.

■ The Player will display the result of this tool.

20 | Chapter 1   Toxik Tutorial



At this point, it would be a good idea to name your tools to avoid any
confusion.

To name the tools, do the following:

1 Select the Radial Ramp node.

2 Locate the name field in the lower right corner of the Tool Details area.

3 Highlight the field and enter the name “ramp sky.”

4 Select the Blend & Comp node.

5 Name this Blend & Comp “B&C Land”.

Notice that the Image Import tool took the name from the image sequence
we pointed to.

Save your composition by hitting Ctrl + S (Windows and Linux) or Cmd + S
(Mac).

Importing Footage (Alternate Method)
Now it is time to bring in more footage; you will use Image Import nodes
again but access them a little differently this time.
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To import footage, do the following:

1 Go to the File menu and choose “Import.”

2 The File browser dialog box appears.

3 Click the Bookmark button to open the bookmarks options.

4 Click on the Red Car Renders bookmark from the bookmarks list.

You can use the views options to control how the sequences will be displayed
in the browser.

To use the view options, do the following:

1 Click on the View label.

2 Click on the Thumbnails option located at the top of the options to turn
on the thumbnails.

3 Select all the files except the BG Land file, which we have already
imported.

You can use all the normal hotkeys you are familiar with such as click holding
the Shift key or Ctrl key to select multiple files at once.

■ With the files selected click the import button.
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■ Click the small X in the upper right corner to close the dialog box.

Looking at the Schematic view you will see all the files that were selected have
been imported in the comp using image import nodes.

You can use hotkeys to organize the nodes within the Schematic view:

1 Bring the cursor over the Schematic view.

2 Hold the Ctrl key and hit the L key.

This will organize all the nodes. If you want you can select each of the image
import nodes to see the footage. Since the Player is still set to display tool
output you can play back each render pass. For the car there is a diffuse pass,
a reflection pass, a disco pass, the shadow pass, an occlusion pass and a motion
vector pass. For the land there is the original BG Land sequence plus a shadow
pass and a z-depth pass.
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Connecting Passes and Renders
You will use more Blend & Comp nodes to connect all of these different passes
and renders. With the B&C Land node selected you will use the Pick List to
add a new Blend & Comp after this selected node.

■ Click on the Pick List tab located in the Tool Details area to bring the Pick
List to the front.

The Pick List is a collection of tools that you can customize and control.
Alternatively, you can use it as it is.

■ Make sure the B&C Land node is selected in the Schematic view.

■ Locate the Blend & Comp tool in the Compositing pick list, the fourth list
from the left.

■ Select the Blend & Comp tool and drag it into the Schematic view.

If you drop the tool on the connecting line it would behave exactly as it did
when adding a tool from the Gate UI tool list. Alternatively, you can drop it
on the actual node for the B&C Land.

■ Drag the Blend & Comp tool and release the cursor over the B&C Land
node.

The Gate UI appears again, and several different options are offered in the
Gate UI.

■ To add this tool after the currently selected tool swipe east (Add After
Current).

Doing this will add the new Blend & Comp tool, and the output from the
B&C Land node will now be connected to the back input of the new Blend &
Comp.
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You could click on the output of the Land Shadow node and drag and connect
it as before but there is a hotkey to connect nodes very easily.

To connect the Land Shadow Image Import node to the front input, do the
following:

1 Move the Land Shadow node above the newest Blend & Comp node.

2 Click in an empty area of the Schematic view to deselect all nodes.

3 Hold the Shift key.

4 Select the Blend & Comp node and move it so the front input kisses or
touches the output of the Land Shadow node.

5 The output of the Land Shadow node is now connected to the front input
of that Blend & Comp node.

WARNING This is a very fast connection method, but be careful when there
are multiple inputs as you might accidentally connect the wrong inputs. If
you do connect inputs incorrectly, and you want to cut the connection, hold
the Ctrl key, then click and drag across the connection line to cut the
connection. The cursor will change to a scissors icon as you click and drag.
You can also hold the Alt key and then click and drag a node to remove it
from a connection. Additionally, you can use the Alt key to connect tools that
are not connected to any flow. Hold the Alt key and drag a node onto a
connection line

6 Select the new Blend & Comp node.

7 Click the Blend & Comp tab in the Tool Details area to access the naming
field.

8 In the name field, enter B&C Land Shadow and hit the Enter key to
rename the node.
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9 Select the B&C Land Shadow node in the Schematic view.

10 Hold the Ctrl key and hit the P key to access the Pick List.

11 Double-click the Blend & Comp tool in the Pick List.

Because you had the B&C Land Shadow node selected when you double-
clicked on the Blend & Comp in the Pick list, a new Blend & Comp tool was
added after the B&C Land Shadow node, and the output of the B&C Land
Shadow node was connected to the back input of the newly added Blend &
Comp tool.

Compositing The Renders
Now you will start to composite the different render passes for the car.

To do this, do the following:

1 Zoom in and pan over in the Schematic as needed to see the car shadow
Image Import node.
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2 Select the car shadow Image Import node.

3 Right-click on the node to access the contextual right-click menu. The
top option is the Pick List and all the tools in it. The top Pick List category
is the most recent one. Here you will see the most recent tools you have
added.

4 Click on the Blend & Comp tool from the Pick List.

Because you right-clicked on the node and clicked on a tool from the
Pick List, Toxik will offer the gate again with the same option as you saw
before when we dropped a tool on a selected node.

5 Swipe through the east gate and choose “Add After Current”.

6 Another Blend & Comp is added with the Car Shadow Image Import
node connected to the back input of the newly added Blend & Comp.

7 Connect the FG Car Image Import node to the front input for the new
Blend & Comp.

8 Select the new Blend & Comp node and access the tools parameters in
the Tool Details area.

9 Rename the new Blend & Comp tool to B&C Car Shadow.

Using Hotkeys to Copy and Paste Tools
and Nodes
Now you will composite the reflection pass but first we’ll try a really quick
method to copy and paste tools and nodes in the Schematic view using a
hotkey.

Do the following:

1 Zoom and pan the Schematic view to see the B&C Car Shadow.
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2 Move the Car Reflection Image Import node near the B&C Car Shadow.

3 Hold the C key on the keyboard.

4 Click on the B&C Car Shadow node to select it and drag the node to
create a copy of it.

This hotkey is the same as using the copy and paste.

5 Connect the output of the original B&C Car Shadow node to the back
input of the new copied B&C Car Shadow2 node.

6 Connect the Car Reflection Image Import node to the front input.

7 Select the B&C Car Shadow2 node to access the tools parameters in the
Tool Details area.

8 Rename this copied B&C Car Shadow2 node to “B&C Car Reflection”.

Changing the Blend Mode
Follow these steps to change the blend mode for the front input, which is
the Car Reflection Image Import node:

1 Select the B&C Car Reflection node to access the tools, parameters in the
Tool Details Areas.

2 Then, in the Tool Details Area, locate the blend mode option.

3 Click on the blend mode label that reads “Normal” to display all possible
blend modes.
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4 Select the Add option from the list and the reflection pass is
mathematically added over the back input, which is the car diffuse and
shadow.

5 Click in the front opacity field and decrease the value to decrease the
reflections on the car.

6 Connect the B&C Car Reflection output to the front input of the last
Blend & Comp node.

7 Select the last Blend & Comp node in the Schematic view to see the result
in the Player.
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Compositing the Occlusion Pass
You will now add one more Blend &Comp tool to composite the occlusion
pass over all of our other nodes. Use the quick copy and paste method we
learned earlier, along with the Alt key, to fit the new node in the flow.

Now do the following:

1 Hold the C key down and click and drag the last Blend & Comp to create
a copy of it.

2 Then with the new Blend & Comp selected, hold the Alt key.

3 Select and drag the new copied Blend & Comp tool on to the connection
line before the output node, and it will be added to the flow.

4 Connect the occlusion pass image import node’s output to the front
input of the new Blend & Comp node.
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5 Select the newest Blend & Comp node to access the tools parameters in
the Tool Details Area.

6 In the name field, rename the Blend & Comp node to “B&C Occlusion
Pass”.

7 With the B &C Occlusion Pass node selected, locate the blend mode
option in the Tool Details Area.

8 Click on the Blend mode label that reads “Normal” to display all possible
blend modes.

9 Select the Multiply option from the list; the Occlusion Pass is
mathematically multiplied over the car and land.

10 Click in the Front Gain Opacity field and decrease the value to control
the depth and effect of the occlusion pass.
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Adding Color Correction to Fine Tune
Results
Now you will add a Color Correction tool to the FG Car Image Import node
to fine tune the color of the car:

1 Press the tilde (~) key or click the middle-mouse button to display the
Gate UI.

2 Drag the cursor through to the east direction or right through the gate.

3 Click on the Color Correction folder to display the color correction tools
below.

4 Select the CC Basics tool and drag it into the Schematic view.

5 Position the cursor and tool icon over the output of the FG Car image
import node.

6 The output of the node will be highlighted when the cursor and tool icon
are over it.

7 Release the cursor, and the CC Basics tool is added after the FG Car image
import node.
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NOTE If you accidentally drop the CC Basics tool on the node itself, the Drop
Gate will appear with several options, as was discussed earlier. If this happens,
swipe east to select “Add After Current.” Conversely, if you drop the tool directly
on the highlighted output of a node, it will be added and connected without the
Drop Gate appearing.

If you select the CC Basics node, you’ll see there are a lot of controls associated
with this tool. Additionally, if you’re familiar with other Autodesk products
like Autodesk Flame®,, Autodesk Flint®, Autodesk Smoke®, or Autodesk
Combustion®, you’ll already know how powerful this tool is.

Now, do the following:

1 Select the CC basics node to access the tools parameters in the Tool Details
area.

2 Make sure the Master is enabled under the Ranges options, located on
the far left side of the Tool Details area.

3 Locate the color wheel on the left side.

4 Position your cursor over the center of the color wheel and click and drag
toward the red hue. This adjustment will affect the hue balance and gain
balance at the master level.

5 Drag the master control in the color wheel until the hue balance is about
1.3 and the gain balance is about 0.4. When rotating the master control,
you are affecting the hue balance, while the distance that you drag the
control from the center affects the gain balance.
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NOTE As you drag you will see the value fields for the hue balance and gain
balance changing. You could also adjust these fields independently, if needed,
using these fields. The color wheel allows you to adjust them at the same
time.

6 Locate the saturation field in the CC basics Tool Details area and adjust
the saturation value to 0.55.

7 Position your cursor over player and hit the 7 key above the letter keys
to set the display of the Player to composition output.

These adjustments are affecting the entire car, but you only want it to affect
the red paint color of the car. For this you can use what is called pixel masking
in Toxik.

Node Details and Pixel Masking
The CC Basics node has multiple inputs similar to the Blend & Comp tool.
The black input is always the masking input.
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This input is used to control what pixels will be affected by the adjustment
you make with any tool. The powerful part of this input is what you connect
it to. It can be a mask or an image and you can control what channel will be
used from that image. On the Tool Details area for the CC Basics tool, you’ll
notice the tool has multiple tabs: the CC Basics tab, the Ranges tab, and the
Masking tab.

Now do the following:

1 Click on the Masking tab on the CC Basics Tool Details area to display
the masking panel for the CC basics tool.

On the Masking tab, you can create a mask directly from this panel in
this tutorial. You can use the Car Disco Image Import node as the masking
input.

2 Pan in the Schematic view using the space bar to locate the Car Disco
Image Import node.

3 Select it and move it near the CC Basics node. As you drag and move a
node in the Schematic view, the view will be panning automatically.

4 Then, connect the output of the Car Disco Pass Image Import node into
the input for the masking on the CC Basics node.

5 Select the CC Basics node again. On the Masking tab, you will now see
the Car Disco pass name in the name field.
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6 Bring your cursor over the Player and hit the 6 key above your letter keys
to set the display to be tool output.

7 In the Schematic view, select the Car Disco Pass image import node and
you’ll see the image is two solid colors.

The car disco pass was rendered out with these 2 colors to be used as
selection tools for the different elements of the car. The solid green is the
red paint on the car and the blue is the white strip across the car.
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8 Locate the channel options on the masking tab for the CC Basics tool,
which, by default, is set to alpha.

9 Click on the label that reads alpha to expand the list of channels.

10 Click on the green option from the list.

Now the color correction only affects the red paint on the car because
the masking option on the CC Basics tool is using only the green channel
information from the disco pass.

11 Hold the Ctrl key and hit the S key to save your comp.
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Adding Blur Tools
Now you’ll need to add some Blur tools.

To add the tools, do the following:

1 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.

2 Drag the cursor through to the east direction or right through the gate.

3 Select the Filtering folder in the tools panel.

4 Click and drag a Blur tool and drop it on the connection line between
the Car Shadow node and the B&C Car Shadow node.
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The Player is currently set to tool output. You want to adjust the blur
parameters while viewing the main output of the comp.

5 Bring your cursor over the Player.

6 Press the seven key above the letter keys to set the Player’s display to
composition output.

7 Select the Blur node in the Schematic view to access the tools parameters
in the Tool Details area.

8 Adjust the X and Y radius fields in the Blur Tool Details area to a value
of 4.5 (The radius should be linked by default).
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To further adjust the shadow of the car, you can decrease the opacity
setting on the B&C Car Shadow node.

9 Click and select the B&C Car Shadow node in the Schematic view.

Since the shadow and the blur are connected to the back input of this
Blend & Comp tool, you will want to decrease the back input’s opacity.

10 Locate the back opacity field on the B&C Car Shadow Tool Details area
and enter a value of 0.65.

Repeat this same process for the shadow for the land.

11 Select the Blur tool applied to the car.

12 Hold the C key then click and drag the node to create a new copy of the
blur tool.

13 Release the C key.
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14 Press and hold the Alt key and drag the new blur tool in between the
Land Shadow Image Import node and the B&C Land Shadow node to
connect it there.

15 Select the B&C Land Shadow node in the Schematic view to access the
tools parameters in the Tool Details area.

Since the shadow and the blur are connected to the front input of this
Blend & Comp we’ll want to adjust the front opacity.

16 Locate the front opacity field on the B&C Land Shadow Tool Details area
and enter a value of 0.65.
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17 Hit the L key with the cursor over the player to watch the playback.

Adding Motion Blur and Depth of Field
To complete your comp you will now add some motion blur and depth of
field. To do this you will add another Blur tool just before the output. You
can drag and drop a tool into the Schematic view or you can drag and drop
a tool into the Player to add tools.

Now do the following:

1 Hit the tilde (~) key or click the middle-mouse button to display the Gate
UI.

2 Drag the cursor through to the east direction or right through the gate.

3 Select the filtering folder to display the filtering tools.

4 Select the Blur tool from the tools and drag and drop it into the Player.
The Drop gate appears again with several options.

5 Swipe south through the gate to choose "Add Before Primary Output”
and the Blur tool will be added just before the output.

6 Select the Blur node in the Schematic view to access the tools parameters
in the Tool Details area.
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7 In the name field, rename the Blur tool to “Blur Motion Depth” and hit
the Enter key.

Looking at the Blur node in the Schematic view you see there are several
inputs. The top input is the image input, then there is the modulation
input and below that is the forward vector input.

We have imported two more images using Image Import nodes: the
motion vector pass for the car named Car Motion, and the Z-depth pass
for the land named land ZDepth. Connect the Land ZDepth Image Import
node into the Modulation input on the Blur Motion Depth node and
connect the Car Motion Image Import node into the Forward vectors
input of the Blur Motion Depth node.

8 Position the Land ZDepth image import node and the Car Motion image
import node near the Blur Motion node.

9 Click and drag the output of the Land ZDepth node and connect it to
the modulation input of the Blur Motion Node.

10 Click and drag the output of the Car Motion node and connect it to the
vector input of the Blur Motion Node.
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11 Go to the third frame in the timeline by moving the current frame
indicator.

12 Select the Blur Motion Depth node and you’ll see multiple tabs in the
Tool Details area.

13 Click on the vectors tab to access the parameters for the vector blur.

14 Set the vectors length field to 4 leaving the width set to 0.

You’ll notice that the back tire, which is starting to rotate in the frame,
is now blurred.
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15 Go to the last frame by holding the Shift key and hitting the right arrow
key.

16 You will see the car has driven away from the camera at the last frame.

17 Click on the modulation tab on the Blur Tool Details area.

18 Locate the X and Y radius fields and set the X Radius to 3, since the link
option is active by default this will adjust the Y radius also.

Now we see the elements in the scene further from the camera become
blurred. But because of the sharp edge of the alpha from the Land ZDepth
sequence we see the blur ends abruptly and there are artifacts along the
edge of the mountain. To solve this on the modulation tab there are
parameters you can adjust.

19 On the modulation tab, locate and adjust the Max Radius to 9.00.

20 Locate and adjust the Min Alpha to 0.9 so that the edge will soften and
be much more natural looking.
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Save your composition and playback the frames to see the end result.

Rendering the Results
In order to render the results, first do the following:

1 Select the output node in the Schematic view to access the output
parameters in the Tool Details area.

2 Locate the Renders tab in the output Tool Details area.

3 Click on the render tab to access the render settings for this output node.

When you render your composition, by default, Toxik will create a folder
named “renders” at the same location you have saved the composition.
Your rendered sequence files will be saved to this renders folder. Looking
at the render Tool Details area you will see the path field for the file name.
By default, the naming of the sequence files is based on the version name
and the output name. There is a browse button to change the default
location where the files will be saved to; for the purposes of this tutorial,
leave this set to the default. You will edit the script so that the name of
the file will be the name of the output in the composition.

4 In the file name path, highlight the word “<version>_” including the
greater-than and less-than signs, and the underscore dash.
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5 Press the backspace key. Now the sequence will match the name of the
output.

6 With the output node still selected, locate the name field along the right
side of the Tool Details area.

7 Highlight the text field and type “Red Car Final” then click Enter.

You can control the file format by clicking the label under File Format.

8 Locate the file format option.

9 Click on the label that currently reads EXR to expand the file format list.

10 Click on the PNG option to change the file format.
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Then go to the File menu and choose Render.

Select the Ouptut(s) and Frames to Render
The render dialog box opens; if you had multiple outputs, you could select
them, but in this tutorial, there is only one. The dialog box also shows all the
formatting information and the path and end file’s name. You can change
the frames to be rendered if you like. Click the Start button in the lower right
corner to start the render.
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The render progress bar appears along the bottom and when the render is
complete the dialog box will close.

Go to the File menu and choose Import. Navigate to the Toxik 101 folder and
you will see the rendered file. You can import it and play it back.
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Summary
In this tutorial, you have learned the basics of Toxik. You have learned to
customize the UI, create compositions, control formats of compositions, import
footage, add tools, adjust parameters, work in the Schematic view and finally
render your composition.
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